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Credit Citation Information for Manuals: 

Developed and updated by Angela Williams for CESBA. CESBA encourages the distribution of this 

information. Please credit appropriately when portions are cited.  

The preferred citations are:  

CESBA (2021) Adult Education Curriculum, Essential Skills for Internet Use Manual https://cesba.com. 

CESBA (2021) Adult Education Curriculum, Essential Skills for Word Processing Manual 

https://cesba.com. 
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Additional resources and further reading may be found at https://cesba.com, including the ability to 
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and to The Ministry of Labour, Training and Skills Development. 
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https://cesba.com/
https://cesba.com/
https://cesba.com/
https://cesba.com/
mailto:info@cesba.com
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Pre-course Information for Instructors 
 

 

These courses instruct essential skills for the Internet and Microsoft 

Office programs. They are designed to be a self-guided learning process 

for each learner. Learners can work independently, at their own pace 

and try activities with classroom guidance from their course 

practitioners. 

All manuals contain activities to practice skills learned, task-based 

reviews, demonstrations to apply multi-step digital tasks, and OALCF 

milestone prompts. 

Learners taking these courses will need: 

• a USB (memory stick) for saving activities, 

• a digital or printed paper copy of the manual, 

• online access and access to a computer or laptop that has MS 

Word, PowerPoint and Excel applications, and 

• any learners working with digital (non-printed) copies of the 

manuals will require Adobe Reader software to view the course 

material. 

Helpful information particular to each manual is available at the 

beginning of each book. 
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Considerations Made for At Home Learners 
 

While best practices delivering this course would be to offer in-class 

instruction, directions prompting using email to turn in demonstrations 

as an alternate for home learners have been added to each module.  

These were added after the necessary school lockdowns in 2020 and 

2021 to address the need for programs to have “work from home” 

options for their learners. 

Distribution Options 
 

The practitioner can provide printed paper copies of the manuals to 

each learner or offer a digital PDF copy of the manuals (on a USB or by 

email). The Internet Use manual has written response activities and 

needs to be printed out for learners, therefor an At Home version of 

this course has now been created as an alternative to allow PDF 

distribution for this manual. It offers interactive links and options for 

participants to email demonstration tasks to the course instructor. 

 

The home version of the Internet course can 

be provided to learners working outside of the 

classroom or offered to those working in class 

in PDF form to reduce printing costs. 
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In-class learners are asked to print out demonstration activities for their 

practitioners. Out of class learners are directed to email attachments of 

demonstration tasks to instructors. 

Example: 

  

 

*In order to deliver these courses outside of the classroom, instructors 

will need to provide an email for questions and demonstrations to at 

home/online learners. If email is not a desired approach (for example: if 

an instructor is using assignments in Teams or another online classroom 

program) then the instructor should provide the appropriate 

submission directions to their learners upon starting these manuals.  
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Resources to Assist with Learning from a PDF File 
 

The next few pages share online tutorials and worksheets with 

screenshots to assist learners using the digital, PDF versions of the 

courses. 

 

Helpful Online Resources to Assist Learners  

 

How to send an attachment via email for beginners: 

https://lifehacker.com/how-to-send-an-email-with-an-attachment-for-

beginners-5803366 

How to download a free copy of Adobe Reader: 

 

https://www.youtube.com/watch?v=vURDphi8vJI 

 

Helpful Worksheets for Learners 

 

Please see the worksheets on the following pages.  

https://lifehacker.com/how-to-send-an-email-with-an-attachment-for-beginners-5803366
https://lifehacker.com/how-to-send-an-email-with-an-attachment-for-beginners-5803366
https://www.youtube.com/watch?v=vURDphi8vJI
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Switching Between Programs Using the Task Bar 

 

 

The bar at the bottom of your screen is called the Task Bar. 

The Windows button you use to open programs is on the left. 

You can use the Search Bar to look for programs and files on your 

computer. 

When you are using programs, the icon (logo) for these programs will 

appear on your task bar. 

In the picture above, you see the icon for Microsoft Edge, Google 

Chrome, the File Manager (folder icon), as well as Word, Excel, 

PowerPoint, Microsoft Teams and Adobe Reader. All these programs 

are currently open on this individual’s computer. 

Yours will look different. It will show the pictures of what you are using 

on your computer. 

If you need to move back and forth between the Internet and a 

program or between 2 programs, just click the icon for the program you 

want to go to on the Task Bar. Once you have clicked the icon that 

program will open. 
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Splitting a Screen in Word 
 

If you need to view two documents at once, you can set up your Word 

view, so that you can navigate between two screens. 

*This can also be very helpful if you are working on a Word course 

at home. Creating a blank document and splitting the screen will 

allow you to have both your blank work area and a workbook 

open at the same time. 

To be able to split screen, you will need two open documents.  

To split a screen, click on the View tab. Then click View Side by Side. 

 

Hint: You can double check that you have opened two documents by 

clicking on your Word icon on the bottom task bar of your screen. 

 

 



8 
Practitioner’s Guide for Essential Skills Digital Manuals - CESBA 

Opening Two Documents for Side by Side 

Step 1: Click on the paper icon on your Quick Access Toolbar to open a 

document. 

 

 

 

 

 

Step 2: Type the words page one in this document. 

Step 3: Click on the paper icon to open a second document. 

Step 4: Type page two in this document. 

Step 5: Click the View tab in one of your documents and then click 

on View Side by Side. 

 

Step 6: You will see the two documents open beside each other. 
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Each 

document 

has its own 

side and 

bottom scroll 

bars. 

 

The information in each Tab on each screen will be compacted for 

the new screen size, but everything is still there. 

Step 7: To return to one screen, click on the View tab on the first 

document, then the Window icon and then click on View Side by 

Side once again. 
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Opening a PDF Document in Word 

 

 

1. Open the Word program. 

2. Click on the File Tab. 

 
3. Click Open.  

 

4. Click Browse. 

 

5. Choose the PDF file you wish to open in Word. 

 

6. Click Open. 
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Short Cut - Setting Up the Quick Access Tool Bar 
 

 

1. Click on the down arrow on the Quick Access tool bar to choose options. 

2. Click on the options you want to add to the toolbar. Some options to add 

include: New, Open, Save, Print, Undo, and Redo. 

3. You will see the icons appear on the Quick Access Toolbar. 

 

4. Hover (place your mouse without clicking) your mouse over the icon to see 

what each icon does. 

5. You can use these icons (pictures) instead of your File Tab when working on 

your document. 

 

Top left of your screen 
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Further Learning and Additional Digital Resources for Instructors 

 

 

Digital Resources Web Address 
Online Link 

CESBA’s LBS Digital Literacy 
Curriculum 

https://cesba.com/cesba-launches-lbs-digital-
curriculum/ 
 

Digital Technology Resources, 
including Online and Offline 
Learning, Learning with Technology – 
Lesson Plan and Assessment 

https://alphaplus.ca/content-type/resources/ 
 

Technology Section includes Email, 
Basics, and MS Office 

https://edu.gcfglobal.org/en/subjects/tech/ 
 

Webwise, Using the Web http://www.bbc.co.uk/webwise/topics/using-the-
web/     

ABC Internet Matters https://abclifeliteracy.ca/all-programs/internet-
matters/ 

Basic Digital Skills including Windows 
10, Email, YouTube and Google Maps 

https://www.digitallearn.org/courses 
 

Computer Training Series including 

Getting to Know Your Computer, 
Facebook, Shopping Online 

https://www.cbal.org/computer-training.html 
 

Digital Online Courses including 
Conquer your Fear of Digital 
Technology, Computing for College 
and Careers, Word, Excel etc. 

http://learninghub.ca/course-list-content/57 
 

Getting Started with Computers https://assessment.digitalliteracyassessment.org/
basic-computer-skills/practice/getting-started-
with-computers 
 

Online courses including 
Introduction to Social Media and 
Making Sense of the Internet 

https://goodlearninganywhere.com/courses/ 
 

Youth Teaching Adults, including 
Skype, Facetime, Duo and Zoom 

https://youthteachingadults.ca/resources/ 
 

https://cesba.com/cesba-launches-lbs-digital-curriculum/
https://cesba.com/cesba-launches-lbs-digital-curriculum/
https://alphaplus.ca/content-type/resources/
https://edu.gcfglobal.org/en/subjects/tech/
http://www.bbc.co.uk/webwise/topics/using-the-web/
http://www.bbc.co.uk/webwise/topics/using-the-web/
https://abclifeliteracy.ca/all-programs/internet-matters/
https://abclifeliteracy.ca/all-programs/internet-matters/
https://www.digitallearn.org/courses
https://www.cbal.org/computer-training.html
http://learninghub.ca/course-list-content/57
https://assessment.digitalliteracyassessment.org/basic-computer-skills/practice/getting-started-with-computers
https://assessment.digitalliteracyassessment.org/basic-computer-skills/practice/getting-started-with-computers
https://assessment.digitalliteracyassessment.org/basic-computer-skills/practice/getting-started-with-computers
https://goodlearninganywhere.com/courses/
https://youthteachingadults.ca/resources/
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Digital Resources Web Address 
Online Link 

CESBA’s Work Skills Manual, Use 
Digital Technology Module 

https://cesba.com/resources/lbs-work-skills-manual/ 
 

Essential Skills for Computer Use 
Manuals includes Internet Use, Word 
Processing, Presentations and 
Spreadsheets  

Available late spring 2021 
www.cesba.com/resources 
 
 

Smart Devices: How Your Phone 
Talks to Everything 

https://www.lambtoncollege.ca/online/free-mini-
courses/ 
 

Digital Literacy Modules https://www.llsc.on.ca/digital-literacy-modules 
 

Parts of the Computer https://dlnmovingonup.ca/lessons/using-the-
computer/  

 

Milestone Suggestions 
 

Please refer to the next section to view suggestion milestones for the courses. 

  

https://cesba.com/resources/lbs-work-skills-manual/
http://www.cesba.com/resources
https://www.lambtoncollege.ca/online/free-mini-courses/
https://www.lambtoncollege.ca/online/free-mini-courses/
https://www.llsc.on.ca/digital-literacy-modules
https://dlnmovingonup.ca/lessons/using-the-computer/
https://dlnmovingonup.ca/lessons/using-the-computer/
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Instructor’s Suggested Milestone Checklist – Slide Show Presentations 
 

 

 

 

Recommended Milestone Present 
milestone to 
learner 

  

M. 3 (A1.2) 
Find and Use Information; for 
Employment, Independence, 
Apprenticeship, or 
M.4 (A1.2) 
Find and Use Information; for 
Secondary and Post-Secondary 

After page 21 of 
PowerPoint 
manual 

  

M. 17 (B1.3) 
Make a presentation for all goal 
paths 

After completion 
of manual 

  

Milestone 36 (B4) 
Express yourself creatively for all 
goal paths 

After completion 
of manual 
(Learner may 
use PowerPoint 
to create a 
collage, poetry, 
photo album 
with stories, 
etc.) 

  

M. 56 (D.3) 
Use a wide variety of software for 
all goal paths 

After page 53 of 
manual 

  

M. 58 (E.2) 
Manage learning for all goal paths 

After page 53 of 
manual 

  

This is a list of milestones suggested for this cours . These are not 

all mandatory and can be chosen on a learner to learner basis by 

the instructor. Completion of 2 milestones will be a good 

demonstration of the skills attained by learners from the learning 

materials provided in this course. 
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Instructor’s Suggested Milestone Checklist – Word Processing 

 

 

 

 

Recommended Milestone Present 
milestone to 
learner 

  

M. 3 (A1.2) 
Find and Use Information; for 
Employment, Independence, 
Apprenticeship, or 
M.4 (A1.2) 
Find and Use Information; for 
Secondary and Post-Secondary 

At end of 
manual 

  

M. 18 (2.1)  
Write continuous text; for 
Employment, Independence, 
Apprenticeship, or 
or 19 (2.1) 
Write continuous text; for 
Secondary and Post-Secondary 

After Memo 
exercise on page 
51 

  

M. 56 (D.3) 
Use a wide variety of software for 
all goal paths 

After completion 
of manual  

  

M. 58 (E.2) 
Manage learning for all goal paths 

After completing 
extra activities 
and checklist in 
post-manual 
activities 

  

  

This is a list of milestones suggested for this cours . These are not 

all mandatory and can be chosen on a learner to learner basis by 

the instructor. Completion of 2 milestones will be a good 

demonstration of the skills attained by learners from the learning 

materials provided in this course. 
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Instructor’s Suggested Milestone Checklist – Spreadsheets 
 

 

 

 

Recommended Milestone for 
Essential Skills for Spreadsheets 

Present 
milestone to 
learner 

Date of 
successful 
completion 

Date to be retaken if 
not successfully 
completed 

M. 6 (A1.3) 
Find and Use Information; for 
Employment and Apprenticeship, or 
M.7 (A1.3) 
Find and Use Information; for 
Secondary and Post-Secondary 

After page 23 
of manual 

  

M.30 (B3.2b) 
Create a Table to Organize and 
Compare 
(Learner must have Internet skills to 
complete this milestone) 

After page 83 
of manual 

  

M. 56 (D.3) 
Use a wide variety of software for all 
goal paths 

After page 
107 of 
manual 

  

M. 58 (E.3) 
Manage learning for all goal paths 

After page 
113 of 
manual 

  

Milestones that may apply if this manual is accompanied by additional math 

activities from instructor on basic math functions and budgeting. 

M. 37 or 38 (C.1.1) 
Understand and Use numbers, 
Money management 

After page 
65 of 
manual 

  

M. 40 (C1.3) 
Understand and Use Numbers, 
Create a budget  

After page 
104 of 
manual 

  

This is a list of milestones suggested for this cours . These are not 

all mandatory and can be chosen on a learner to learner basis by 

the instructor. Completion of 2 milestones will be a good 

demonstration of the skills attained by learners from the learning 

materials provided in this course. 
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Instructor’s Suggested Milestone Checklist – Internet Use 

 

 

 

 

 

 

 

  

 

 

 

Recommended Milestone Present 
milestone 
to learner 

Date of 
successful 
completion 

Date to be retaken if 
not successfully 
completed 

M. 3 (A1.2) 
Find and Use Information; for 
Employment, Independence, 
Apprenticeship, or 
M.4 (A1.2) 
Find and Use Information; for 
Secondary and Post-Secondary 

After page 
23 of 
Internet 
manual 

  

M. 55 (D2) 
Conduct an Internet search; for all 
goal paths 
 

After page 
40 of 
Internet 
Manual 

    

M. 58 (E.2) 
Manage learning for all goal paths 

After page 
77  

  

This is a list of milestones suggested for this cours . These are not 

all mandatory and can be chosen on a learner to learner basis by 

the instructor. Completion of 2 milestones will be a good 

demonstration of the skills attained by learners from the learning 

materials provided in this course. Instructor may decide to add a 

numeracy milestone after page 73. 

 


